
Bienvenue !

Nous vous remercions d'avoir acheté notre capteur de température,
d'humidité et de pression atmosphérique AZ-Delivery BME280. Dans les
pages suivantes, vous apprendrez à utiliser et à configurer cet appareil
pratique.

Amusez-vous bien !
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Zones d‘application
Éducation et enseignement : Utilisation dans les écoles, universités et établissements de formation pour enseigner les bases 
de l‘électronique, de la programmation et des systèmes embarqués. Recherche et développement : Utilisation dans des pro-
jets de recherche et développement pour créer des prototypes et des expériences dans les domaines de l‘électronique et de 
l‘informatique. Développement de prototypes : utilisation dans le développement et le test de nouveaux circuits et dispositifs 
électroniques. Projets de loisirs et de création : utilisé par les passionnés d‘électronique et les amateurs pour développer et 
mettre en œuvre des projets de bricolage.

Connaissances et compétences requises
Compréhension de base de l‘électronique et du génie électrique. Connaissance de la programmation, notamment du langage 
de programmation C/C++. Capacité à lire des schémas et à concevoir des circuits simples. Expérience de travail avec des com-
posants électroniques et de la soudure.

Des conditions de fonctionnement
Le produit ne peut être utilisé qu‘avec les tensions spécifiées dans la fiche technique pour éviter tout dommage. Une source 
d’alimentation CC stabilisée est requise pour le fonctionnement. Lors de la connexion à d‘autres composants et circuits élec-
troniques, les limites maximales de courant et de tension doivent être respectées pour éviter les surcharges et les domma-
ges.

Conditions environnementales
Le produit doit être utilisé dans un environnement propre et sec pour éviter les dommages causés par l‘humidité ou la pous-
sière. Protéger le produit des rayons directs du soleil (UV)

Utilisation prévue
Le produit est conçu pour être utilisé dans des environnements d’enseignement, de recherche et de développement. Il est 
utilisé pour développer, programmer et prototyper des projets et des applications électroniques. Le produit Sensor n‘est pas 
conçu comme un produit de consommation fini, mais plutôt comme un outil destiné aux utilisateurs techniquement avertis, 
notamment les ingénieurs, les développeurs, les chercheurs et les étudiants.

Utilisation inappropriée et prévisible
Le produit n‘est pas adapté à un usage industriel ou à des applications liées à la sécurité. L‘utilisation du produit dans des 
dispositifs médicaux ou à des fins de voyages aériens et spatiaux n‘est pas autorisée.

élimination
Ne pas jeter avec les ordures ménagères ! Votre produit est conforme à celui européen Directive relative aux déchets 
d‘équipements électriques et électroniques devant être éliminés de manière respectueuse de l‘environnement. Les matiè-
res premières précieuses qu‘elles contiennent peuvent être recyclées devenir. L‘application de cette directive contribue à la 
protection de l‘environnement et de la santé. Utilisez le point de collecte mis en place par votre commune pour rapporter et 
Recyclage des anciens appareils électriques et électroniques. N° d‘enregistrement DEEE : DE 62624346

décharge électrostatique
Attention : Les décharges électrostatiques peuvent endommager le produit. Remarque : Mettez-vous à la terre avant de tou-
cher le produit, par exemple en portant un bracelet antistatique ou en touchant une surface métallique mise à la terre.       

consignes de sécurité
Bien que notre produit soit conforme aux exigences de la directive RoHS (2011/65/UE) et ne contienne aucune substan-
ce dangereuse en quantités supérieures aux limites autorisées, des résidus peuvent toujours être présents. Respectez les 
consignes de sécurité suivantes pour éviter les risques chimiques : Attention : La soudure peut produire des fumées pouvant 
être nocives pour la santé. Remarque : utilisez un extracteur de fumées de soudure ou travaillez dans un endroit bien ventilé. 
Si nécessaire, portez un masque respiratoire. Attention : Certaines personnes peuvent être sensibles à certains matériaux 
ou produits chimiques contenus dans le produit. Remarque : En cas d‘irritation cutanée ou de réactions allergiques, cesser 
l‘utilisation et, si nécessaire, consulter un médecin. Attention : Gardez le produit hors de portée des enfants et des animaux 
domestiques pour éviter tout contact accidentel et l‘ingestion de petites pièces. Remarque : Conservez le produit dans un 
récipient sûr et fermé lorsqu‘il n‘est pas utilisé. Attention : Évitez tout contact du produit avec des aliments et des boissons. 
Remarque : Ne stockez pas et n‘utilisez pas le produit à proximité d‘aliments pour éviter toute contamination. Bien que notre 



produit soit conforme aux exigences de la directive RoHS (2011/65/UE) et ne contienne aucune substance dangereuse en 
quantités supérieures aux limites autorisées, des résidus peuvent toujours être présents. Respectez les consignes de sécurité 
suivantes pour éviter les risques chimiques : Attention : La soudure peut produire des fumées pouvant être nocives pour la 
santé. Remarque : utilisez un extracteur de fumées de soudure ou travaillez dans un endroit bien ventilé. Si nécessaire, portez 
un masque respiratoire. Attention : Certaines personnes peuvent être sensibles à certains matériaux ou produits chimiques 
contenus dans le produit. Remarque : En cas d‘irritation cutanée ou de réactions allergiques, cesser l‘utilisation et, si né-
cessaire, consulter un médecin. Attention : Gardez le produit hors de portée des enfants et des animaux domestiques pour 
éviter tout contact accidentel et l‘ingestion de petites pièces. Remarque : Conservez le produit dans un récipient sûr et fermé 
lorsqu‘il n‘est pas utilisé. Attention : Évitez tout contact du produit avec des aliments et des boissons. Remarque : Ne stockez 
pas et n‘utilisez pas le produit à proximité d‘aliments pour éviter toute contamination. Le produit contient des composants 
électroniques sensibles et des arêtes vives. Une manipulation ou un assemblage incorrect peut entraîner des blessures ou des 
dommages. Respectez les consignes de sécurité suivantes pour éviter les risques mécaniques : Attention : le circuit imprimé et 
les connecteurs du produit peuvent présenter des arêtes vives. Soyez prudent pour éviter les coupures. Remarque : Portez des 
gants de protection appropriés lors de la manipulation et de l‘assemblage du produit. Attention : évitez toute pression excessi-
ve ou toute contrainte mécanique sur la carte et les composants. Remarque : montez le produit uniquement sur des surfaces 
stables et planes. Utilisez des entretoises et des boîtiers appropriés pour minimiser les contraintes mécaniques. Attention : 
assurez-vous que le produit est solidement fixé pour éviter tout glissement ou chute accidentelle. Remarque : Utilisez un sup-
port approprié ou un montage sécurisé dans des boîtiers ou sur des plaques de montage. Attention : assurez-vous que toutes 
les connexions des câbles sont connectées de manière sécurisée et correcte pour éviter les tensions et les débranchements 
accidentels.  Remarque : Acheminez les câbles de manière à ce qu‘ils ne soient pas sous tension et ne présentent pas de risque 
de trébuchement. Le produit fonctionne avec des tensions et des courants électriques qui, s‘ils sont mal utilisés, peuvent ent-
raîner des chocs électriques, des courts-circuits ou d‘autres dangers. Respectez les consignes de sécurité suivantes pour éviter 
les risques électriques : Attention : utilisez le produit uniquement avec les tensions spécifiées. Remarque : Les limites de per-
formances du produit se trouvent dans la fiche technique associée Attention : Évitez les courts-circuits entre les connecteurs 
et les composants du produit Remarque : Assurez-vous qu‘aucun objet conducteur ne touche ou ne ponte le circuit imprimé. 
Utilisez des outils isolés et faites attention à la disposition des connexions. Attention : N‘effectuez aucune intervention sur le 
produit lorsqu‘il est connecté à une source d‘alimentation. Remarque : Débranchez le produit de l‘alimentation avant d‘ef-
fectuer des modifications de circuit ou de connecter ou de retirer des composants. Attention : Ne dépassez pas les courants 
nominaux spécifiés pour les entrées et sorties du produit. Remarque : Les limites de performance du produit se trouvent dans 
les spécifications techniques ou dans la fiche technique Attention : Assurez-vous que les sources d‘alimentation utilisées sont 
stables et correctement dimensionnées. Remarque : utilisez uniquement des alimentations testées et adaptées pour éviter les 
fluctuations de tension et les surcharges. Attention : Maintenez une distance suffisante par rapport aux pièces sous tension 
pour éviter tout contact accidentel. Remarque : Assurez-vous que le câblage est disposé de manière sûre et claire en fonction 
de la tension utilisée. Attention : Utilisez des boîtiers isolants ou des capots de protection pour protéger le produit du contact 
direct. Remarque : placez le produit dans un boîtier non conducteur pour éviter tout contact accidentel et court-circuit. Le 
produit et les composants qu‘il contient peuvent devenir chauds pendant le fonctionnement. Une mauvaise manipulation 
ou une surcharge du produit peut entraîner des brûlures, des dommages ou un incendie. Respectez les consignes de sécuri-
té suivantes pour éviter les risques thermiques : Attention : assurez-vous que le produit est utilisé dans les températures de 
fonctionnement recommandées. Remarque : La plage de températures de fonctionnement recommandée est généralement 
comprise entre -40 °C et +85 °C. Vérifiez les informations spécifiques dans la fiche technique du produit.  Attention : Ne placez 
pas le produit à proximité de sources de chaleur externes telles que des radiateurs ou la lumière directe du soleil. Remarque : 
Assurez-vous que le produit est utilisé dans un endroit frais et bien ventilé. Attention : Assurez-vous que le produit est bien 
ventilé pour éviter toute surchauffe. Remarque : utilisez des ventilateurs ou des dissipateurs de chaleur lorsque vous utilisez le 
produit dans une enceinte fermée ou dans un environnement avec une circulation d‘air limitée. Attention : Montez le produit 
sur des surfaces résistantes à la chaleur et dans des boîtiers résistants à la chaleur. Remarque : Utilisez des matériaux de boîtier 
pouvant résister à des températures élevées pour éviter tout dommage ou tout risque d‘incendie. Attention : Mettez en place 
une surveillance de la température lors de l‘utilisation d‘un boîtier et, si nécessaire, des mécanismes de protection qui arrêtent 
le produit en cas de surchauffe. Remarque : Remarque : Utilisez des capteurs de température et un logiciel approprié pour 
surveiller la température du produit et arrêter le système si nécessaire. Attention : évitez les surcharges pouvant provoquer 
un échauffement excessif des composants. Remarque : Pour éviter toute surchauffe, ne dépassez pas les limites de courant 
et de tension spécifiées. Attention : Les courts-circuits peuvent générer une chaleur importante et provoquer des incendies. 
Remarque : Assurez-vous que toutes les connexions sont correctes et sécurisées et qu‘aucun objet conducteur ne peut provo-
quer accidentellement des courts-circuits.     
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Introduction

Le capteur BME280 est un capteur barométrique numérique dans un
petit boîtier. Le capteur se compose de capteurs de température,
d'humidité et de pression combinés. Le capteur BME280 peut être utilisé
dans une variété d'applications telles que la domotique pour le chauffage
et la climatisation, les dispositifs de surveillance de la santé, les
systèmes de navigation, les stations météorologiques, les dispositifs de
combinés, l'IoT et de nombreuses autres applications. La conception
compacte et la faible consommation d'énergie sont bénéfiques pour la
portabilité et les appareils alimentés par batterie. La haute précision et le
temps de réponse rapide en font un candidat parfait pour étendre les
fonctionnalités de nombreux autres appareils de choix.

Le BME280 supporte l'interface série I2C. Le capteur possède l'adresse
I2C prédéfinie, qui est 0x76. L'adresse I2C peut être modifiée à la valeur
0x77, ce qui n'est pas couvert dans cet eBook.

La consommation de courant est inférieure à 1mA, lorsqu'il est en mode
mesure, et à 5μA lorsqu'il est en mode veille.
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Caractéristiques
» Gamme de tension de fonctionnement : de 3.3V à 5V DC

» Consommation de courant : < 1mA

» Gamme de température : de -40 °C à 85 °C

» Précision de la température : ±1.0°C

» Gamme de pression : de 300 à 1100 hPa

» Précision de la pression : ±1hPa

» Gamme d'humidité : de 0 à 100% RH

» Précision de l'humidité : ±3%

» Dimensions : 9 x 11 x 2mm [0.35 x

0.43 x 0.078inch]
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Le Pinout
Le capteur BME280 possède quatre broches. Le brochage est présenté

sur l'image suivante :

Le capteur est équipé d'un régulateur de tension LM6206 3.3V et d'un

translateur de niveau de tension. Les broches du capteur BME280

peuvent fonctionner sur des tensions comprises entre 3.3V et 5V sans

danger pour le capteur lui-même.
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Comment configurer l'IDE Arduino
Si l'IDE Arduino n'est pas installé, suivez le link et téléchargez le fichier

d'installation pour le système d'exploitation de votre choix.

Pour les utilisateurs de Windows, double-cliquez sur le fichier .exe

téléchargé et suivez les instructions de la fenêtre d'installation.
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Pour les utilisateurs de Linux, téléchargez un fichier portant l'extension

.tar.xz, qui doit être extrait. Lorsqu'il est extrait, allez dans le répertoire

extrait et ouvrez le terminal dans ce répertoire. Deux scripts .sh doivent

être exécutés, le premier appelé arduino-linux-setup.sh et le second

appelé install.sh.

Pour exécuter le premier script dans le terminal, ouvrez le terminal dans

le répertoire extrait et exécutez la commande suivante :

sh arduino-linux-setup.sh user_name

user_name - est le nom d'un superutilisateur dans le système

d'exploitation Linux. Un mot de passe pour le superutilisateur doit être

saisi lors du lancement de la commande. Attendez quelques minutes

pour que le script complète tout.

Le deuxième script appelé script install.sh doit être utilisé après

l'installation du premier script. Exécutez la commande suivante dans le

terminal (répertoire extrait) : sh install.sh

Après l'installation de ces scripts, allez dans le dossier All Apps, où est

installé l'IDE Arduino.
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Presque tous les systèmes d'exploitation sont livrés avec un éditeur de

texte préinstallé (par exemple, Windows est livré avec Notepad, Linux

Ubuntu avec Gedit, Linux Raspbian avec Leafpad, etc.) Tous ces

éditeurs de texte conviennent parfaitement à l'objectif de l'eBook.

La prochaine étape est de vérifier si votre PC peut détecter une carte

Arduino. Ouvrez l'IDE Arduino fraîchement installé, et allez dans :

Tools > Board > {votre nom de conseil ici}

{votre nom de conseil ici} devrait être l'Arduino/Genuino Uno, comme on

peut le voir sur l'image suivante :

Le port auquel la carte Arduino est connectée doit être sélectionné. Aller

à : Tools > Port > {le nom du port va ici}

et lorsque la carte Arduino est connectée au port USB, le nom du port

peut être vu dans le menu déroulant de l'image précédente.
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Si l'Arduino IDE est utilisé sous Windows, les noms des ports sont les

suivants :

Pour les utilisateurs de Linux, par exemple, le nom du port est

/dev/ttyUSBx, où x représente un nombre entier entre 0 et 9.
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Comment configurer le Raspberry Pi et Python
Pour le Raspberry Pi, il faut d'abord installer le système d'exploitation,

puis tout configurer pour qu'il puisse être utilisé en mode “Headless”. Le

mode “Headless” permet de se connecter à distance au Raspberry Pi,

sans avoir besoin d'un écran de PC, d'une souris ou d'un clavier. Les

seuls éléments utilisés dans ce mode sont le Raspberry Pi lui-même,

l'alimentation électrique et la connexion Internet. Tout ceci est expliqué

en détail dans le livre électronique gratuit :

Raspberry Pi Quick Startup Guide

Le système d'exploitation Raspbian est livré avec Python préinstallé.
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Connexion du module avec le microcontrôleur
Connectez le capteur BME280 au microcontrôleur comme indiqué sur le

schéma de connexion suivant :

BME280 pin MC pin Couleur des
câbles

VIN 3.3V Câble Rouge
GND GND Câble Noir
SCL A5 Câble Orange
SDA A4 Câble Bleu
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Bibliothèque pour l'IDE Arduino
Pour utiliser le capteur avec le microcontrôleur, il est recommandé de

télécharger une bibliothèque externe pour celui-ci. La bibliothèque qui

est utilisée dans cet eBook est appelée Adafruit BME280. Pour la

télécharger et l'installer, ouvrez l'IDE Arduino et allez dans :

Tools > Manage Libraries

Lorsqu'une nouvelle fenêtre s'ouvre, tapez BME280 dans la boîte de

recherche et installez la bibliothèque appelée Adafruit BME280 Library

fabriquée par Adafruit comme indiqué sur l'image suivante :

Lorsque le bouton Installer est cliqué, l'invite à installer des bibliothèques

supplémentaires s'affiche, comme dans l'image suivante :

Cliquez sur Installer tout pour terminer l'installation de la bibliothèque

BME280 d'Adafruit.
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Exemple de sketch
L'exemple de sketch suivant est un sketch modifié de la bibliothèque

BME280 d'Adafruit :

File > Examples > Adafruit BME280 Library > bme280test

#include <Wire.h>

#include <Adafruit_Sensor.h>

#include <Adafruit_BME280.h>

Adafruit_BME280 bme; // I2C

void setup() {

Serial.begin(9600);

// default address from library is 0x77

// bool communication = bme.begin();

bool communication = bme.begin(0x76);

if (!communication) {

Serial.println("Could not find a valid BME280 sensor");

Serial.println("check wiring, address, sensor ID!");

Serial.print("SensorID was: 0x");

Serial.println(bme.sensorID(), 16);

Serial.println("ID of 0xFF probably means a bad address\n");

while (true) { };

delay(10);

}

else {

Serial.println("Communication established!\n");

}

}
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void loop() {

Serial.print("Temperature = ");

Serial.print(bme.readTemperature());

Serial.println(" *C");

Serial.print("Pressure = ");

Serial.print(bme.readPressure() / 100.0F);

Serial.println(" hPa");

Serial.print("Humidity = ");

Serial.print(bme.readHumidity());

Serial.println(" %\n");

delay(1000);

}
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Téléchargez le sketch vers le microcontrôleur et ouvrez Serial Monitor

(Tools > Serial Monitor). Le résultat devrait ressembler à la sortie sur

l'image suivante :
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Le sketch commence par inclure trois bibliothèques : Wire,

Adafruit_Sensor et Adafruit_BME280.

Ensuite, l'objet appelé bme est créé avec la ligne de code suivante :

Adafruit_BME280 bme;

Dans la fonction setup(), la communication série est lancée avec la

vitesse de transmission de 9600bps.

Ensuite, l'objet bme est initialisé avec la ligne de code suivante :

bme.begin(0x76)

où 0x76 est l'adresse I2C du capteur.

La fonction begin() renvoie une valeur booléenne, qui indique si

l'initialisation est réussie ou pas. Cette valeur est stockée dans la

variable appelée communication, avec la ligne de code suivante :

bool communication = bme.begin(0x76);

À la fin de la fonction setup(), le succès de l'initialisation est vérifié. Si

elle est réussie, le message Communication établie est affiché dans le

Serial Monitor. Si l'initialisation n'a pas réussi, les données d'erreur sont

affichées dans le Serial Monitor.
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Dans la fonction loop(), les données de température, pression et

humidité sont lues avec les lignes de code suivantes :

bme.readTemperature()

bme.readPressure() / 100.0F

bme.readHumidity()

Après cela, les données sont affichées dans Serial Monitor avec les

lignes de code suivantes :

Serial.print(bme.readTemperature()); Serial.print(bme.readPressure() /

100.0F);

Serial.print(bme.readHumidity());

Il y a un intervalle d'une seconde entre deux mesures à la fin de la

fonction loop() : delay(1000);
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Connecter le capteur avec Raspberry Pi
Connectez le capteur BME280 avec le Raspberry Pi comme indiqué sur

le schéma de connexion suivant :

BME280 pin Raspberry Pi pin Physical pin No. Couleur du
câble

GND GND 9 Câble Noir
VIN 3V3 1 Câble Rouge
SCL GPIO3 5 Câble Bleu
SDA GPIO2 3 Câble Vert
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Activation de l'interface I2C
Afin d'utiliser le module avec Raspberry Pi, l'interface I2C doit être

activée. Ouvrez le menu suivant :

Application Menu > Preferences > Raspberry Pi Configuration

Dans la nouvelle fenêtre, sous l'onglet Interfaces, activez le bouton radio

I2C, comme le montre l'image suivante :
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Pour détecter l'adresse I2C du capteur connecté à l'interface I2C du

Raspberry Pi, l'outil i2c-tools doit être installé, sinon, ouvrez le terminal

et exécutez la commande suivante :

sudo apt-get install i2c-tools

Pour détecter l'adresse I2C, ouvrez un terminal et exécutez la

commande suivante :

i2cdetect -y 1

Le résultat devrait ressembler à celui de l'image suivante :

Où 0x76 est l'adresse I2C du capteur.

Si l'interface I2C du Raspberry Pi n'est pas activée, et que la commande

précédente est exécutée, l'erreur suivante sera levée :
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Python scripts
Deux scripts sont créés, un pour toutes les fonctions et l'autre pour
l'utilisation de ces fonctions, pour une meilleure lisibilité. Le code du
premier script est le suivant :

import smbus

import time

from ctypes import c_short

from ctypes import c_byte

from ctypes import c_ubyte

DEVICE = 0x76 # Default device I2C address

bus = smbus.SMBus(1) # Rev 2 Pi, Pi 2 & Pi 3 uses bus 1

# Rev 1 Pi uses bus 0

def getShort(data, index):

# return two bytes from data as a signed 16-bit value

return c_short((data[index+1] << 8) + data[index]).value

def getUShort(data, index):

# return two bytes from data as an unsigned 16-bit value

return (data[index + 1] << 8) + data[index]

def getChar(data, index):

# return one byte from data as a signed char

result = data[index]

if result > 127:

result -= 256

return result
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def getUChar(data, index):

# return one byte from data as an unsigned char

result = data[index] & 0xFF

return result

def readBME280ID(addr=DEVICE):

# Chip ID Register Address

REG_ID = 0xD0

(chip_id, chip_version) = bus.read_i2c_block_data(addr, REG_ID, 2)

return (chip_id, chip_version)

def readBME280All(addr=DEVICE):

# Register Addresses

REG_DATA = 0xF7

REG_CONTROL = 0xF4

REG_CONFIG = 0xF5

REG_CONTROL_HUM = 0xF2

REG_HUM_MSB = 0xFD

REG_HUM_LSB = 0xFE

# Oversample setting

OVERSAMPLE_TEMP = 2

OVERSAMPLE_PRES = 2

MODE = 1

# Oversample setting for humidity register

OVERSAMPLE_HUM = 2

bus.write_byte_data(addr, REG_CONTROL_HUM, OVERSAMPLE_HUM)

control = OVERSAMPLE_TEMP << 5 | OVERSAMPLE_PRES << 2 | MODE

bus.write_byte_data(addr, REG_CONTROL, control)

# Read blocks of calibration data from EEPROM

cal1 = bus.read_i2c_block_data(addr, 0x88, 24)

cal2 = bus.read_i2c_block_data(addr, 0xA1, 1)

cal3 = bus.read_i2c_block_data(addr, 0xE1, 7)
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# one tab

# Convert byte data to word values

dig_T1 = getUShort(cal1, 0)

dig_T2 = getShort(cal1, 2)

dig_T3 = getShort(cal1, 4)

dig_P1 = getUShort(cal1, 6)

dig_P2 = getShort(cal1, 8)

dig_P3 = getShort(cal1, 10)

dig_P4 = getShort(cal1, 12)

dig_P5 = getShort(cal1, 14)

dig_P6 = getShort(cal1, 16)

dig_P7 = getShort(cal1, 18)

dig_P8 = getShort(cal1, 20)

dig_P9 = getShort(cal1, 22)

dig_H1 = getUChar(cal2, 0)

dig_H2 = getShort(cal3, 0)

dig_H3 = getUChar(cal3, 2)

dig_H4 = getChar(cal3, 3)

dig_H4 = (dig_H4 << 24) >> 20

dig_H4 = dig_H4 | (getChar(cal3, 4) & 0x0F)

dig_H5 = getChar(cal3, 5)

dig_H5 = (dig_H5 << 24) >> 20

dig_H5 = dig_H5 | (getUChar(cal3, 4) >> 4 & 0x0F)

dig_H6 = getChar(cal3, 6)

# Wait in ms (Datasheet Appendix B: Measurement

# time and current calculation)

wait_time = 1.25 + (2.3 * OVERSAMPLE_TEMP) + ((2.3 *

OVERSAMPLE_PRES) + 0.575) + ((2.3 * OVERSAMPLE_HUM) + 0.575)

time.sleep(wait_time / 1000) # Wait the required time

# Read temperature / pressure / humidity

data = bus.read_i2c_block_data(addr, REG_DATA, 8)

pres_raw = (data[0] << 12) | (data[1] << 4) | (data[2] >> 4)
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# one tab

temp_raw = (data[3] << 12) | (data[4] << 4) | (data[5] >> 4)

hum_raw = (data[6] << 8) | data[7]

# Refine temperature

var1 = ((((temp_raw >> 3) – (dig_T1 << 1))) * (dig_T2)) >> 11

var2 = (((((temp_raw >> 4) – (dig_T1)) * ((temp_raw >> 4) -

(dig_T1))) >> 12)*(dig_T3)) >> 14

t_fine = var1 + var2

temperature = float(((t_fine * 5) + 128) >> 8);

# Refine pressure and adjust for temperature

var1 = t_fine / 2.0 - 64000.0

var2 = var1 * var1 * dig_P6 / 32768.0

var2 = var2 + var1 * dig_P5 * 2.0

var2 = var2 / 4.0 + dig_P4 * 65536.0

var1 = (dig_P3 * var1 * var1 / 524288.0 + dig_P2 * var1) / 524288.0

var1 = (1.0 + var1 / 32768.0) * dig_P1

if var1 == 0:

pressure = 0

else:

pressure = 1048576.0 - pres_raw

pressure = ((pressure - var2 / 4096.0) * 6250.0) / var1

var1 = dig_P9 * pressure * pressure / 2147483648.0

var2 = pressure * dig_P8 / 32768.0

pressure = pressure + (var1 + var2 + dig_P7) / 16.0

# Refine humidity

humidity = t_fine - 76800.0

humidity = (hum_raw - (dig_H4 * 64.0 + dig_H5 / 16384.0 * humidity)) * (dig_H2 / 65536.0 *

(1.0 + dig_H6 / 67108864.0 * humidity * (1.0 + dig_H3 / 67108864.0 * humidity)))

humidity = humidity * (1.0 - dig_H1 * humidity / 524288.0)
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# one tab

if humidity > 100:

humidity = 100

elif humidity < 0:

humidity = 0

return temperature / 100.0, pressure / 100.0, humidity

Sauvegardez le script sous le nom de bme280.py. Le code du script est

modifié à partir du script.
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Voici le code du script principal :
import bme280

from time import sleep

dgr = u'\xb0'

print('[Press CTRL + C to end the script!]')

try:

while(True):

temperature,pressure,humidity = bme280.readBME280All()

print('Temperature = {}{}C'.format(temperature, dgr))

print('Humidity = {.2f}%'.format(humidity))

print('Pressure = {.2f}hPa\n'.format(pressure))

sleep(1)

except KeyboardInterrupt:

print('Script end!')
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Sauvegardez le script sous le nom de bme280main.py dans le même

répertoire où vous avez sauvegardé le script bme280.py. Pour exécuter

le script principal, ouvrez le terminal dans le répertoire où les scripts sont

enregistrés et exécutez la commande suivante :

python3 bme280main.py

Le résultat devrait ressembler à celui de l'image suivante :

Pour arrêter le script, appuyez sur CTRL + C sur le clavier.

Le premier script n'est pas expliqué dans cet eBook.
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Le script bme280main.py commence par importer le script bme280 et la

fonction sleep de la bibliothèque time.

Ensuite, la variable dgr est créée, où la valeur du signe du degré UTF

est stockée.

Ensuite, le bloc de code try-except est créé. Dans le bloc de code try, le

bloc de boucle indéfinie (while True :) est créé. Dans ce bloc de code, la

fonction readBME280All() est utilisée pour lire les données du capteur.

Cette fonction renvoie un tuple de trois éléments : température, pression

et humidité. Ensuite, les données sont affichées dans le terminal. Dans

la sortie, pour arrondir le nombre à virgule flottante à deux décimales

après la virgule, la ligne de code suivante est utilisée :

print('Humidity = {.2f}%'.format(humidity))

Le bloc de code except suivant est exécuté lorsque l'on appuie sur

CTRL + C sur le clavier. C'est ce qu'on appelle le KeyboardInterrupt.

Lorsque ce bloc de code est exécuté, le message Script end ! s'affiche

dans le terminal.
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Il est maintenant temps d'apprendre et de réaliser des projets par

vous-même. Vous pouvez le faire à l'aide de nombreux exemples de

scripts et autres tutoriels, que vous trouverez sur Internet.

Si vous recherchez des produits de haute qualité pour Arduino et

Raspberry Pi, AZ-Delivery Vertriebs GmbH est l'entreprise idéale

pour vous les procurer. Vous recevrez de nombreux exemples

d'application, des guides d'installation complets, des livres

électroniques, des bibliothèques et l'assistance de nos experts

techniques.

https://az-delivery.de

Amusez-vous !

Mentions légales

https://az-delivery.de/pages/about-us
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